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The Preprocessor tab tells the Cisco MXE 3000 how to adjust video, color, and audio settings before 
incoming video is encoded. 

This section includes the following topics:

• Introduction to the Preprocessor Tab, page 5-1

• Understanding Preprocessor Settings, page 5-3

• Video Settings, page 5-4

• Color and Noise Reduction Settings, page 5-11

• Advanced Settings, page 5-14

• Watermark Settings, page 5-19

• V-Chip Gfx, page 5-21

• Audio Settings, page 5-24

• Flash Graphics Overlay, page 5-27

See also: Working With Jobs in the Preview Window.

Introduction to the Preprocessor Tab
Preprocessor settings allow you to adjust video, color, and audio settings to improve the quality of the 
incoming video before it is encoded. The Cisco MXE 3000 allows only one preprocessor tab per Job 
Profile. 

When you open the Cisco MXE 3000 UI, the window contains one tab: File Job. To add preprocessor 
settings, from the main menu, select File > New Job Profile. A Preprocessor tab, shown in Figure 5-1, 
displays. 
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  Introduction to the Preprocessor Tab
Figure 5-1 Preprocessor Tab

Note It is possible to save a Job Profile without including a Preprocessor tab, though this is generally only 
done by advanced users building specialized workflows. A Job Profile that does not include a 
Preprocessor tab can only be used for submission of *.REF files.
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Understanding Preprocessor Settings
Generally, the type of source footage determines the preprocessor settings. You can modify the settings 
to make the source footage look as good as possible before encoding. Different settings are used 
depending on the nature and quality of the incoming video. 

The preprocessor allows you to adjust the following settings on the preprocessor subtabs, shown in 
Figure 5-2: 

• Video Settings

• Color and Noise Reduction Settings

• Advanced Settings

• Watermark Settings

• V-Chip Gfx

• Audio Settings

• Flash Graphics Overlay

See also: Working With Jobs in the Preview Window.
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  Video Settings
Figure 5-2 Preprocessor Subtabs

Video Settings
The Preprocessor Video subtab, shown in Figure 5-3, allows you to adjust the following settings:

• Video

• Crop

• Bumpers and Trailers

See also: Capturing from HD Video Sources.
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  Video Settings
Figure 5-3 Preprocessor Tab: Video Subtab

Video
Table 5-1 describes the video settings on the Video subtab.

Table 5-1 Video Subtab Settings and Descriptions

Setting Description

CPU Usage Determines the resources available for preprocessing.

• Optimize for Quality: Both the capture card hardware capability and 
software preprocessing capabilities will be used. This results in the highest 
quality output.

• Optimize for Speed: Only capture card hardware capability will be used 
for preprocessing, leaving the maximum amount of resources available for 
encoding and distribution. This results in the fastest preprocessing.
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Frame Rate Indicates the maximum frame rate for the selected encoders. Frame Rate 
cannot be adjusted from the Preprocessor tab.

Max Width Determined by the maximum value set on the selected encoder tabs. Width 
cannot be adjusted from the Preprocessor tab.

Max Height Determined by the maximum value set on the selected encoder tabs. Height 
cannot be adjusted from the Preprocessor tab.

Frame Type Displays the frame type assigned on the MPEG-2 encoder tab. If no MPEG-2 
encoder is included in the Job Profile, the display defaults to Progressive.

Field Order Specifies which field will be used as the top field during de-interlacing.

• Automatic Top will be automatically detected. This is recommended.

• First on Top will be used as the top field.

• Second on Top will be used as the top field.

• Frame Footage does not require de-interlacing.

If you have selected an incorrect field order, it will be evident in the quality of 
the output. Some lesser-used formats will incorrectly report field order. Also, 
AVI and other formats may not specify the field order. If setting Field Order to 
Automatic yields poor results, specify First on Top or Second on Top.

Single Field Specifies the method used to de-interlace interlaced video before it is encoded.

• Single Field Only: The top field will be interpolated. Half of the temporal 
information will be omitted because only information from the first field 
will be used. Recommended for fast-motion video.

• Two Fields Blend: Both fields are blended into a single Progressive field. 
All temporal information will be maintained. Recommended for 
slow-moving or stationary video images.

Table 5-1 Video Subtab Settings and Descriptions (continued)
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Inverse Telecine Inverse Telecine algorithm tracks the 3:2 pull-down cadence even in portions 
of the media where, due to a lack of motion, the cadence is difficult to detect. 

The chance of a telecine phase change is 80% at every edit point. 

Note Inverse Telecine is not compatible with Temporal Smoothing. If 
Temporal Smoothing is turned on (set greater than 1), then Inverse 
Telecine cannot be used. Requesting both results in a warning message, 
and Inverse Telecine is disabled. Inverse Telecine in the Perfect mode 
can be used when the media is known to have an unchanging telecine 
phase. 

This setting is used to reverse the frame insertion performed by the telecine 
process when film is converted to video. Inverse Telecine will remove inserted 
frames, which are unnecessary.

• Off processes video with frames as they are. Telecine frames will be 
retained, if they are present.

• The Cisco MXE 3000 will try to detect the telecine pattern and recreate the 
original frames. It constantly analyzes and adjusts to discontinuities (due 
to an edit, for example) in the telecine pattern. This is the most commonly 
used mode.

• Perfect 3:2 analyzes the footage and then adheres to a pattern without 
dynamically adjusting it. This mode should be used on unedited footage 
that was created using a 3:2 pull-down process. 

Note Perfect 3:2 does not work when Audio Drift Compensation is enabled 
in Audio Preferences. 

Table 5-1 Video Subtab Settings and Descriptions (continued)
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Add/Remove VBI Note Only use this control when the vertical cropping is turned off.

This setting helps maintain proper aspect ratios when converting between 
media types that do not both require a VBI. For example, if the a broadcast 
format is being converted to a Web format, the VBI will be stripped from the 
video before adjusting image size, thus preserving the overall aspect ratio of 
the media.    

• Yes: VBI will be stripped from VBI sources and added to non-VBI 
sources.

• No: No action taken.

• Auto: If the incoming source contains a VBI and the output media does 
not, it will be added. If the input media has no VBI and the output is to an 
analog broadcast format, the VBI will be added.

You can use this feature to strip the VBI out and put in such a way that the 
aspect ratio is maintained when you go from one format to another. We suggest 
leaving this feature set to the default settings. 

Examples: 

• When it is set to Auto, and the input height is 480 (or 486) and the output 
height is 512, or if the input height is 576 and the output height is 608, 32, 
or 26, blank VBI lines are added at the end of the preprocessing stage.

• If the input is 512 and:

– VBI is set to Yes, 32 top lines will be cropped off (similar to setting 
the vertical cropping to 32)

– VBI is set to Auto and the output is 480 (or 486) or 32 (or 26) lines 
will be removed before preprocessing.

•  If the input is 608 and:

– VBI is set to Yes, 32 top lines will be cropped off (similar to setting 
the vertical cropping to 32)

– VBI is set to Auto and the output is 576, 32 lines will be removed 
before preprocessing.

In Point Marks the point in time, relative to the beginning of the clip, to start encoding. 
In points and out points are used when only a section of a larger file will be 
encoded. In points are marked in hh:mm:ss:mmm, where the last section is 
milliseconds.

Out Point Marks the point in time, relative to the beginning of the clip, to stop encoding. 
Out points are marked in hh:mm:ss:mmm, where the last section is 
milliseconds.

Note In points and out points are not related to video timecodes. They are 
measured strictly in time elapsed from the start of the clip. Technically, 
they are not frame accurate, but allow frame accurate capture because 
they measure to the millisecond.

Table 5-1 Video Subtab Settings and Descriptions (continued)
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Crop
Crop settings are used to trim unwanted material from the outer edges of the incoming video image. All 
crop settings are expressed in source video pixels, and the default value for each is 8.

Crop settings do not change the frame size of the finished output. Non-uniform crop results in changes 
to the aspect ratio of the image in the output file. For film-based input that requires a non-uniform crop, 
it is important to match the encoder output size to the cropped input size manually to avoid distorting 
the image.

Table 5-2 describes the crop settings.

Bumpers and Trailers
Table 5-3 describes the bumpers and trailers settings.

Fade In Determines the number of seconds to fade-in from black to full brightness at 
the beginning of the video clip. Values range from 0 to 10 seconds. Fade In time 
is appended to the absolute beginning of the preprocessed file including any 
bumpers that may be added. The default value is 0.

Fade Out Determines the number of seconds to fade out from full brightness to black at 
the end of the video clip. Values range from 0 to 10 seconds, with 0 seconds 
the default. Fade Out time is appended to the absolute end of the preprocessed 
file including any trailers that may be added. 

Table 5-1 Video Subtab Settings and Descriptions (continued)

Table 5-2 Video Subtab Crop Settings and Descriptions

Setting Description

Crop Top Determines the number of pixels to trim from the top of the incoming video image.

Crop Left Determines the number of pixels to trim from the left side of the incoming video 
image. 

Crop Right Determines the number of pixels to trim from the right side of the incoming video 
image. 

Crop Bottom Determines the number of pixels to trim from the bottom of the incoming video 
image. 

Table 5-3 Video Subtab Bumpers and Trailers Settings and Descriptions

Setting Description

Bumper Specifies the file to be used as a bumper at the introduction of the encoded 
clip. Movie files of any Cisco MXE 3000 supported format or still files 
saved with a .mov file extension can be used as bumpers. 

Trailer Specifies the file to be used as a trailer to follow the encoded clip. Movie 
files of any Cisco MXE 3000 supported format or still files saved with a 
.mov file extension can be used as trailers. 
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Capturing from HD Video Sources

The Cisco MXE 3000 supports captures from HD video sources using AJA video capture cards. As set 
in Tools > Preferences > Deck Control Preferences > Video Format, the following modes are currently 
supported: 1080i 59.94/50Hz and 720p 59.94/50Hz. 

As set in the Preprocessor > Video subtab > CPU Usage, HD captures can only operate in two modes: 
Optimized for Speed and Separate Capture from Preprocess. 

• Optimized for Speed: The incoming video is processed by a lower-quality video scaler (if 
necessary) bypassing the main preprocessing pipeline. This is useful for encodes that do not require 
any scaling.

• Separate Capture from Preprocess: Use this setting for higher quality encodes that require scaling 
and other preprocessing features. In this mode, a two-stage preprocessing is employed. On the first 
stage, the incoming video is encoded into a high-bitrate MPEG2/I-frame only MXF format. The 
actual MXF bitrate is set on the Preprocessor tab > MXF Capture Bit Rate. The valid bitrate range 
is 50 to 300 MBits. On the second stage, a regular file-based preprocessing is executed off that MXF 
file. At this point, all user-selected preprocessing settings are applied. The intermediate MXF file 
can be kept or deleted, depending on whether you check the MXF Capture box on the Tools > 
Preferences > General Preferences tab or the Distribution > Output tab. Currently there is no 
distribution option available for the intermediate file. 

Preprocess Specifies whether to apply preprocessor settings to the bumper file. 

• Checked: Specifies that preprocessor settings should be applied to the 
bumper clip. Use the On setting for video clips that have similar 
requirements to those of the source footage.

• Unchecked: Specifies that the bumper clip will not have preprocessor 
settings applied. The clip will be appended to the beginning of the 
source footage as it is. Use the Off setting for animated GIFs or other 
bumper files that do not require the same preprocessing as the source 
footage. 

Separate Capture from 
Preprocess

Instructs the Cisco MXE 3000 to separate the real-time audio and video 
capture step from the preprocessing step. As a result, the 
Cisco MXE 3000 will not apply the preprocessor setting until the media 
acquisition is entirely completed. 

This mode is recommended for encoding jobs with non-standard frame 
sizes such as 400x300 and/or with heavy preprocessor settings such as 
higher level of blur or noise reduction. Separating the preprocessing from 
the capture step guarantees that the preprocessing can be performed even 
while using the capture card as the input device. 

• Checked: Specifies that the preprocessing will occur in two passes. 
The first pass will capture the input completely, and the second pass 
will apply the preprocessing

• Unchecked: Specifies that the preprocessing will occur normally, i.e. 
capture and preprocessing together in the same pass.

MXF Capture Bit Rate See also: Capturing from HD Video Sources.

Table 5-3 Video Subtab Bumpers and Trailers Settings and Descriptions (continued)
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Limitations:

• The HD AJA cards have to be installed in the 64-bit PCI slots capable of passing data at HD rates. 
A high-performance PCI slot should yield ~230MBytes/sec or better. 

• Only I-frame-only HD MPEG2 immediate encodes can be performed in the Optimized for Speed 
mode. There are not enough CPU cycles to perform immediate Long-GOP encodes. This may 
change over time when faster CPUs hit the market. 

• In Separate Capture from Preprocess mode, the bitrate of the intermediate MXF file can 
substantially affect the capture performance/sustainability. Use the lowest bitrate that meets your 
needs. Slower disks may contribute to capture overruns. 

Note Currently, the Cisco MXE 3000 does not support VBI processing of any kind for HD captures. 

Color and Noise Reduction Settings
The Color and Noise Reduction subtab, shown in Figure 5-4, is used to modify the following settings 
that will affect the image quality of the video clip prior to encoding:

• Color

• Noise Reduction
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Figure 5-4 Preprocessor Tab: Color and Noise Reduction Subtab

Color
Table 5-4 describes the color settings.

Table 5-4 Color Settings and Descriptions

Setting Description

Brightness Adjusts luminance as measured against the source video. Slider values range from 
50% (half as bright) to 150% (one and a half times as bright). The total value range 
is from 0 to 200%. Default value is 100%, which leaves brightness unchanged.

Contrast Adjusts separation between the blackest black and the whitest white. Slider values 
range from 50% to 150%. The total valid range is 0 to 200%. The default value is 
100%, which leaves color unchanged.

Hue Adjusts hue of colors in the video from red (decrease) to green (increase). Slider 
values range from -10° to +10°. The total value range is -180° to +180°. The default 
value is 0°. 

Saturation Adjusts the amount of color in the video image expressed as a percentage of source 
video color. Slider values range from 50% to 150%. The total valid value range is 0 
(remove all color) to 200 (double the color). The default value is 100%. 
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Gamma Adjusts the mid-range (gray) luminance values of the video. This adjusts the 
luminance of mid-range colors, leaving black and white values unchanged. The 
mapping is applied in RGB space and each color channel independently receives the 
color correction. Slider values range from 0 to 40. The total value range is 0 to 255. 
The default value is 1.0. 

Black Point Defines the threshold for 100% black. Any pixel below the number entered here will 
be converted to black. Slider values range from 0 to 40. The total valid value range 
is from 0 to 255. The default value is 0. Setting black point higher will reduce detail 
in the dark areas of the video increasing compression quality. 

Transition: Sets the amount of smoothing between black and surrounding colors. 
Black Point affects only pixels below the threshold set. Lower the value to maintain 
the sharpest transition, or increase the value for smoother transition. Values are 0 to 
255. The default value is 15. 

White Point Defines the threshold for 100% white. All pixels above the number entered will be 
converted to white. Values range from 0 to 255. The default value is 255. Setting the 
white point lower will reduce detail in the light areas of the video, increasing 
compression quality. 

Transition: Sets the amount of smoothing between white and surrounding colors. 
Lower the value to maintain the sharpest transition, or increase value for smoother 
transition. Values are 0 to 255. The default value is 15. 

Color Rescale Determines whether color will be expanded from video levels (16-235) to computer 
levels (0-255). Default value is Yes. Most video formats set 100% black (7.5 IRE) 
to 16 when mapped to 8 bit sampling and 100% white (100 IRE) to 235. Most 
computers set 100% black to 0 and 100% white to 255. Color rescale expands the 
range by mapping 16 to 0 and 235 to 255 to ensure that the color range is optimized 
for computer display.

• On: Luminance and color levels will be expanded from video levels (16-235) to 
computer levels (0-255). This is the default setting.

• Off: Luminance and color levels will be unchanged from video levels (16-235).

If encoded video looks murky, with no true blacks or true whites, Color Rescale may 
be Off when it should be On. If encoded video has too much black and white, one 
possible cause may be that Color Rescale is On when it should be Off.

601-709 Color 
Space

Determines how color will be adjusted during conversion from HD to SD or SD to 
HD.

• 601(SD) – 709(HD)

• 709(HD) – 601(SD)

Table 5-4 Color Settings and Descriptions (continued)
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Noise Reduction
Table 5-5 describes the Noise Reduction settings.

Advanced Settings
The Preprocessor Advanced subtab, shown in Figure 5-5, allows you to adjust the following settings: 

• Manage Input Extensions/Enable UGV Extensions

• Line 21/VANC Data

• Closed Captioning

• Aspect Ratio Conversion

Table 5-5 Noise Reduction Settings and Descriptions

Settings Descriptions

Temporal Smoothing Defines how frames are combined for interframe smoothing. This setting 
specifies the number of input frames to average when constructing an 
output frame. Values range from 1 to 4 frames in terms of the input frame 
rate from the source. The default value is 1, which results in no smoothing 
(a frame compared to itself will be an exact match).

Blur Specifies how much to blur the source footage. Slider values range from 0 
to 4.0. The total value range is 0 to 10.0. Blur is generally used at lower 
bit rates to reduce image detail, which improves the overall appearance of 
the finished clip at high compression rates. 

Blurring degrades the image but enables better compression. 

Noise Reduce Used to remove small, irregular detail from the source video. The range of 
values refers to the size of the detail to be removed. Slider ranges are 0 to 
3.0. The total valid values range from 0 to 6.0. The default value is 0.

Unsharp Mask Enabled Used to enhance edge detail in the image without enhancing other detail. 
If checked, the Unsharp Radius and Unsharp Strength sliders are activated.

• Checked: Indicates that Unsharp Mask smoothing will be used. This 
reduces compression efficiency, but can improve perceived clarity of 
the image.

• Unchecked: Indicates that Unsharp Mask smoothing will not be used. 
This is the default value.

Unsharp Mask reduces compression efficiency, but can improve the 
perceived quality of the image. This is recommended for some video 
formats, such as VHS, and for multigenerational images where a sharper 
image is desired. 

Unsharp Radius Used only when Unsharp Mask is set to Yes. Increase the value to increase 
sharpening on larger objects within the image. Slider values range from 0 
to 8.0. Default is 0.

Unsharp Strength Used only when Unsharp Mask is set to Yes. Increase the setting to add 
strength to the sharpening effect. Slider values range from 0 to 200. The 
total range of valid values is 0 to 200. Default value is 100.
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• Timecode

• Subtitles

Figure 5-5 Preprocessor: Advanced Subtab
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Manage Input Extensions/Enable UGV Extensions
Table 5-6 describes the Manage Input Extensions settings.

Table 5-6 Advanced: Manage Input Extensions/Enable UGV Extensions

Setting Description

Mange Input Extensions This option allows you to handle file extensions based on a 
configuration file. 

First, follow these instructions: 

1. Create and save a file that matches the XML format in the following 
example:

Proprietary File Handling XML

<extensions>
      <extension input="ts" treat-as="mpg" />   
      <extension input="" treat-as="gxf" type="directshow" 
/> 
      <extension input="mp4" type="directshow" /> 
      <extension input="avi" type="quicktime" /> 
 </extensions>

In the example above:

• Line 2 tells the Cisco MXE 3000 to treat .ts extensions as .mpg 
extensions and to decode them using the default pipeline.

• Line 3 tells the Cisco MXE 3000 to treat files without an 
extension as .gfx (Grass Valley) files and to decode them using 
DirectShow.

• Line 4 tells the Cisco MXE 3000 to use DirectShow to decode 
.mp4 files.

• Line 5 tells the Cisco MXE 3000 to use QuickTime to decode 
.avi files.

2. From the Cisco MXE 3000 Client User Interface Preprocessor tab, 
select the Advanced tab.

3. Check the new Manage Input Extensions box, click the Select File 
button, and browse to the new XML file (created in Step 1). 

Note Currently, the “treat-as” option cannot be combined with 
type=”quicktime”
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Line 21/VANC Data (CC, V-Chip, CGMS-A)
You can select to add Line 21/VANC settings to the output by specifying the source from the options 
described in Table 5-7. 

Closed Captioning
This feature is not supported currently by the Cisco MXE 3000. 

Aspect Ratio Conversion
The Aspect Ratio Conversion tools provide several methods for scaling media between various formats.   
For example, an image with a 4:3 aspect can be converted to a 16:9 aspect, or vice-versa. 

The Cisco MXE 3000 makes use of pixel aspect ratio information in the conversions and uses default 
assumptions about the pixel aspect ratio based on the pixel dimensions of an image. For example, an 
image size of 720x480 or 720x486 is assumed to be SD NTSC, and is assigned the NTSC pixel aspect 
ratio of 0.9. For complete control, the user may explicitly set both the input media pixel aspect ratio and 
the pixel aspect ratio for the preprocessor output image.

The input dimensions are read from the input media. The preprocessor output dimensions are set by the 
encoder which receives the preprocessed video. Remember that in the case where the preprocessor is 
supplying data for more than one encode, it produces the largest of the requested dimensions. The Aspect 
Ratio Conversion tools specify how to convert the input media to the preprocessor output.

Table 5-7 Line 21/VANC Settings and Descriptions

Source Setting Description

VBI (Line 21) The Cisco MXE 3000 passes the Line 21 information found in the Vertical 
Blanking Interval (VBI) of the source media to the encoded output. The output 
encoding differs depending upon the selected option.

• CC pass thru to VBI

• CC pass thru to MPEG user data

Embedded (Line 
21 /VANC)

The Cisco MXE 3000 passes the closed captioning information found in the 
MPEG user data of the source media (currently only in MPEG-2 based .mov and 
intermediate .ref files) and in an embedded VANC track (currently only in Avid 
DNxHD .mov files) to the encoded output. The output encoding differs depending 
upon the selected option.

• CC pass thru to VBI

• CC pass thru to MPEG user data
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Select one of the following options from the Mode drop-down described in Table 5-8. 

Table 5-8 Aspect Ratio Conversion Settings and Descriptions

Setting Description

Mode • Stretch to fit: This mode stretches or shrinks source media format to the 
dimensions of the preprocessor output. There is no adjustment to 
preserve the original aspect ratio of the image. The pixel aspect ratio 
settings are not used.

• Cropping: This mode changes image size without stretching the image. 
The Cisco MXE 3000 scales the image linearly, so that the output image 
is completely covered. The input and output image edges match in either 
the horizontal or vertical direction. Some of the image is lost to cropping 
in the other direction. The cropping is done equally from top and bottom 
or right and left. Cropping mode uses the supplied pixel aspect ratio 
information.

• Letterbox, Curtains: This mode linearly scales the images until they are 
completely held within the boundaries of the output dimensions. Unused 
space in the vertical direction introduces black bars (letterboxing) 
equally on the top and bottom of the output image. Alternately, if there is 
unused space horizontally, black bars (curtains) appear on the left and 
right sides of the output image. Letterbox/Curtains mode uses the 
supplied pixel aspect ratio information.

• Non-linear Stretch: This mode stretches the image more at the edges and 
not at all in the center. The non-linear stretching is in the horizontal 
direction; the vertical scaling is linear. This option can, for example, 
provides a full 16x9 output image from 4x3 source with no distortion 
near the image center. Non-linear stretch mode uses the supplied pixel 
aspect ratio information.

Input Pixel / Output 
Pixel

These allow you to inform the Cisco MXE 3000 of the input and output 
formats for the purpose of setting the pixel aspect ratios. With the default 
option, the Cisco MXE 3000 makes certain assumptions based on the image 
dimensions. With the custom option, you can explicitly set other numerical 
values for the pixel aspect ratios.
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Aspect Ratio Conversion Examples

Examples are shown in Figure 5-6.

Figure 5-6 Aspect Ratio Conversion Example

Watermark Settings
The Watermark subtab, shown in Figure 5-7, allows you to select a file to be used as a graphic watermark 
(sometimes called a "bug" that normally appears as an overlay in the lower corner of the screen - not to 
be confused with a forensic watermark as set on the Preprocessor tab > Forensics subtab) and set options 
for the location and appearance of the watermark. 
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Figure 5-7 Preprocessor Tab: Watermark Subtab

Table 5-9 describes the watermark settings.

Table 5-9 Graphic Watermark Settings and Descriptions

Setting Description

Image Determines which image file will be used as a watermark. The drop-down shows files 
available from the Watermark directory. The format of the watermark file must be .psd, 
.tga, .pct, or .bmp. 

Origin Identifies the reference point from which X Distance and Y Distance will be measured.

• Bottom-right: Watermark placement will be relative to the lower right corner of 
the source image.

• Bottom-left: Watermark placement will be relative to the lower left corner of the 
source image.

• Top-right: Watermark placement will be relative to the upper right corner of the 
source image.

• Top-left: Watermark placement will be relative to the upper left corner of the 
source image.

The watermark placement is expressed in terms of the input stream for ease of use. The 
Cisco MXE 3000 resizes the watermark accordingly and places it on the encoded 
output. This is important because the watermark is unaffected by other Preprocessor 
settings (except fade). 

If crop settings are set for the incoming video on the Video subtab, watermark 
placement will be measured from the new edges defined by the crop settings.
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V-Chip Gfx
V-Chip Gfx can be used to insert a rating watermark based on the job’s V-Chip settings, or it can enable 
a second watermark similar to the Watermark subtab. Figure 5-8 shows the V-Chip Gfx settings.

See also: Creating a V-Chip Rating Watermark.

Mode Determines the display mode for the watermark image.

• Composite: Straight composite of the watermark onto the source video. If an alpha 
channel is present, it is used in the compositing.

• Luminance: The luminance and hue of the image is altered according to the 
luminance and hue of the watermark.

X Distance Changes the location of the watermark image on the finished output file. This setting 
changes the placement of the watermark along the horizontal axis of the image. 
X-distance is expressed in pixels of the source image x coordinate. Allowed values 
range from -768 to +768. The default value is 0, which places the image at the selected 
Origin.

Y Distance Changes the location of the watermark image on the finished output file. This setting 
changes the placement of the watermark along the vertical axis of the image. Values 
range from -768 to +768. The default value is 0, which results in no change in the 
placement of the image. 

Width Determines the width of the watermark in terms of pixels of the source image. Values 
range from 1 to 768. The default value is 200.

Height Determines the height of the watermark in terms of pixels of the source image. Values 
range from 1 to 576. The default value is 100. 

Opacity Determines how opaque or transparent the watermark image will be. The watermark 
can be made more or less noticeable by adjusting the opacity. Values are 0-200%. The 
default value is 100%. In Composite mode, this is effectively an 'alpha' value, where 
100% means full opacity. In Luminance mode this parameter effectively adjusts the 
strength of the watermark.

Start Time This entry specifies the time when the watermark will appear, measured from the 
beginning of the clip. The format is HH:MM:SS.mmm, where the mmm are 
milliseconds.

Duration This entry specifies the length of time in seconds that the watermark will be applied.

Fade Time This entry specifies the length of time in seconds it takes for the watermark to fade-in 
and fade-out. Fades happen within the duration time of the watermark, so a fade-in 
begins at the start time, and a fade-out finishes when the duration has expired.

Table 5-9 Graphic Watermark Settings and Descriptions (continued)
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Figure 5-8 Preprocessor Tab: V-Chip Gfx Subtab

Creating a V-Chip Rating Watermark

Procedure

Step 1 From the File Job tab > Advanced subtab > V-Chip section, set the Rating Type, Rating, and Rating Flags 
for this job. 

Step 2 On the Preprocessor > V-Chip Gfx subtab, shown in Figure 5-8, from the Source drop-down, select Map 
Submission Rating and select a mapping file. 

or

Click the Edit V-Chip Mapping File button to define the mapping of each rating to a corresponding 
image file, shown in Figure 5-9. You must choose an option in the File menu item to open an existing 
mapping file or create a new one. 
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Figure 5-9 V-Chip Mapping File Editor

Step 3 On the V-Chip Gfx subtab, adjust the remaining settings to control the appearance of the rating 
watermark, as described in Table 5-10. 

Table 5-10 V-Chip Graphic / Second Watermark Settings and Descriptions

Setting Description

Source The source pull-down menu has three choices:

• None disables the subtab, so no watermark is produced. 

• Map Submission Rating causes the Mapping File entry box to appear, which 
allows a mapping file to be specified. The mapping file associates different 
watermark image files with various V-Chip ratings. The V-Chip rating is selected 
at run time on the File Job tab > Advanced subtab > V-Chip section.

• Watermark File causes the Image entry box to appear, which allows a single 
watermark image to be specified. The intent is that this can be used to specify a 
second watermark image in addition to whatever is specified on the Watermark 
subtab. 

Edit V-Chip 
Mapping File

This button brings up a window containing a V-Chip Mapping File template. In order 
to edit this, you must first select either New or Open from the File menu at the top of 
the window. The Mapping file is saved with a file name, and this name can be used in 
the Mapping File entry box described above. The icons on the right side of the V-Chip 
Mapping File Editor activate file-pickers for the V-Chip rating images.
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Audio Settings
The Audio subtab is used to modify settings after any mixing and mapping and before encoding. These 
settings affect the audio quality of the video clip. 

The Audio subtab, shown in Figure 5-10, allows you to adjust the following settings:

• Audio

• Audio Track Insertion

• Filters

See also: Assigning Audio Tracks to Final Encoded Output.

Figure 5-10 Preprocessor Tab: Audio Subtab
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Audio
Table 5-11 describes the Audio settings.

Audio Track Insertion
When checked, this option inserts a silent audio track into the decoded output of the Preprocessor. This 
insertion only occurs if the source file does not contain any audio tracks. If the source file contains audio 
tracks, this option is ignored.

If an encoder profile is set up to encode audio but the source file does not contain audio, the encoder will 
fail. A silent audio track can be inserted to provide an audio source to any encoders that expect/require 
audio.

Filters
Table 5-12 describes the Filter settings.

Table 5-11 Audio Settings and Descriptions

Setting Description

Channels Channels will be determined by the encoder profile(s). They will display Mono or 
Stereo, but this value cannot be changed from the Preprocessor tab. It will be Mono if 
all of the audio in all encoder tabs is set to Mono. If any encoder audio is set to Stereo, 
the output will be Stereo.

Fade In Amount of time allotted for linear fade-in from silence at beginning of clip. Defined in 
seconds. Values range from 0 to 10 seconds with 0 seconds as the default. Default value 
is 0.0 seconds.

Fade Out Amount of time allotted for linear fade-out to silence at the end of clip. Defined in 
seconds. Values range from 0 to 10 seconds with 0 seconds the default.

Table 5-12 Filter Settings and Descriptions

Setting Description

Low Pass Suppresses samples above the frequency assigned. Expressed in kilohertz. 
Slider range is 0 to 24. The default value is 0, which disables the filter.

The term Low Pass indicates that lower frequencies are allowed to pass. 
Audio compression codecs work more efficiently when higher frequencies 
are suppressed.

High Pass Suppresses frequencies below a certain frequency. Expressed in kilohertz 
(kHz). Slider range is 0 to 200. The default value is 0.

The term High Pass indicates that high frequencies are allowed to pass. Some 
types of noise or hum may be present at lower frequencies. Suppressing this 
noise can improve compression efficiency.
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Volume Filter Type Defines how the loudness of the audio is controlled. Specific Filter Type 
choices can activate a slider control in the lower part of the window.

• None: No adjustment is made.

• Adjust: Specifies the percentage by which the volume will be amplified 
or attenuated. The units are linear (waveform) units.

• Normalize: Specifies the percentage of the full scale that the typical 
volume should match. The Normalize setting is single-pass: it does not 
look at the entire audio clip. Instead, it uses a measure of the volume 
obtained in a fading window of approximately 10 seconds duration. 
Values range from 0 (silent) to 100 (maximum volume).

• 2-Pass Normalize: The entire clip is scaled so that the maximum sample 
in the clip is normalized to the given value. The 2-pass normalization is 
valid only with file-based media. Normalization values range from 0 
(silent) to 100 (peak sample set to full scale).

• 1770 2-pass norm: This option enables audio normalization as defined in 
the international standard ITU-R BS.1770. The processing is two-pass, 
meaning that the audio content is scanned once by the Cisco MXE 3000 
to measure the loudness, and scanned again to normalize the loudness. 
ITU-R BS.1770 is commonly used for normalizing 5.1 channel 
surround-sound media. It may also be used with stereo.

Selecting 1770 2-pass norm displays the Target Volume box. Enter the 
desired normalization value here in LKFS units, as defined in the 
standard. These units are similar to dB full-scale units, and are negative. 
Commonly used values are in the range -17 to -25 LKFS.

Volume Adjust For the Adjust option, this value specifies the scaling of the output audio. The 
units are linear (waveform) units as a percentage of the input level. Values are 
0% (silent) to 200%, with 50% as the default. 

Volume Normalize • For the Normalize option, this value specifies the volume of the output 
audio. The value is in linear (waveform) units and is a percentage of full 
scale. Values are 0% (silent) to 100%, with 25% as the default. 

• For the 2-pass Normalize option, this value specifies the amplitude of the 
maximum sample in the audio clip. The value is in linear (waveform) 
units and is a percentage of full scale. Values are 0% to 100%, with 25% 
as the default.

Table 5-12 Filter Settings and Descriptions (continued)
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Flash Graphics Overlay
This section includes the following topics:

• Understanding Graphics Overlay, page 5-27

• Applying Graphic Overlays, page 5-29

• Creating a Metadata File, page 5-31

• Using Animation Controls, page 5-32

Understanding Graphics Overlay
Cisco MXE 3000 Graphics synchronizes video and metadata with graphic templates during transcoding 
to produce dynamic multilayered titles, branded graphics, cross promotions, subtitles, captions, and 
animations. Overlays are suitable for both small screen and large screen applications. Graphic templates 
are produced with Adobe authoring software used by most creative and design professionals. Editors 
incorporate built-in scene changes, animations, 8-bit alpha blending, and transitions – all with runtime 
metadata triggers. Adding graphic overlays to Cisco MXE 3000 output requires two additional inputs:

• A Flash .swf template the defines the attributes of graphical elements including, placement, color, 
and size. For example, text fields in the template are dynamic variables that are defined at run-time.

• An XML metadata description that defines the specific values for the graphical elements that are to 
be applied at encoding to the overlay. For example, titling text is supplied so that the same template 
can be reused on any video clip.

Graphic overlays (geometrical objects, text, metadata text, images, and/or movies) are applied to any 
Cisco MXE 3000-supported output format. The overlay may be applied to main content, bumpers, 
and/or trailers. The overlay is applied over media near the end of the preprocessing. The only video 
preprocessing operation that follows the overlays is forensic watermarking.

You can use any application, including Adobe Flash Pro 8 and Flash Creative Suite 3, Photoshop, and 
After Effects, that produces an .swf file with version 2.0 ActionScript applications to produce the 
graphic overlay template. You then create XML metadata control files in a text editor or a custom 

Compressor This is a single-pass dynamic range compressor with no look-ahead. 
Changing this setting is not recommended for use with file-based encoding. 
The compressor maintains an RMS estimate of the typical audio level with a 
fading memory time constant of many seconds, and compresses relative to 
this empirically measured level. 

The Compressor value is the compression threshold level relative to the 
typical level measured in decibels of audio power. When the threshold is 
exceeded, audio loudness is attenuated by the Compressor Ratio. Therefore, 
lower Compressor values provide more compression. Values are –40 dB to +6 
dB.

Compressor Ratio Determines the amount of attenuation that will occur beyond the point 
defined in the Compressor threshold field. Values for ratio are 1 (no 
compression) to 20 (20:1 approaching limit).

Table 5-12 Filter Settings and Descriptions (continued)
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application. Using the Cisco MXE 3000 Client User Interface, the graphic overlay template (.swf file) 
and the metadata (XML) may be applied independently to each segment. The metadata can be applied 
as a time referenced XML file or can be read from an XML file. 

In addition, the Cisco MXE 3000 supports the following file reference methods:

• Path name

• UNC path name

• URL 

This section includes the following topics:

• Spatial Considerations, page 5-28

• Temporal Considerations, page 5-28

• End of .swf Movie, page 5-28

• Rendered Metadata, page 5-28

• Other Metadata, page 5-28

• Bumpers and Trailers, page 5-29

Spatial Considerations 

The overlays are always rectangular. They are resized according to the preprocessor output dimension. 
They are not stretched, so if the image aspect ratio of the overlay and preprocessor output media do not 
match, the overlay will be sized as large a possible without cropping, meaning that it may not cover all 
of the output media area. The overlay is centered, so there may be strips on the left and right, or strips 
on the top and bottom, that are not covered by the overlay. 

Temporal Considerations 

The overlay .swf files have a specific frame rate to control playback. This may or may not match the 
frame rate of the preprocessor output media. In case of a mismatch, the overlay is temporally stretched 
or compressed to match the output frame rate. Temporal Stretching is done by replicating overlay frames. 
Temporal Compression is done by discarding overlay frames. 

End of .swf Movie 

At the end of an .swf movie, the last frame will continue to be overlayed by default, until the end of the 
preprocessed output. Other behaviors may be programmed into the .swf file, if needed. For example, an 
.swf movie can jump back to the beginning and repeat. 

Rendered Metadata 

It is possible to change rendered metadata text on the overlay during the preprocessing. This is controlled 
by a metadata file that specifies lines of text to embed in the overlay at particular times. 

Other Metadata 

Metadata can be used to control the Flash overlay movie. For example, it is possible to jump to a different 
part of the Flash movie. This is set up in the .swf file during the authoring process. A variable is assigned 
different values to indicate different locations in the .swf movie. 
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Bumpers and Trailers 

Overlays may also be placed on bumpers and trailers, but they are handled completely independently 
from the main clip: the information that controls the overlays is specified separately for bumpers and 
trailers. 

Note The Preprocess box on the Preprocessor > Video subtab, shown in Figure 5-11, must be checked for 
overlays to be placed on bumpers and/or trailers. 

Applying Graphic Overlays
Through the CLUI, the Cisco MXE 3000 allows you to create two kinds of jobs with graphic overlays: 

• Applying Graphic Overlays to a Job with a Job Profile

• Applying Graphic Overlays to a Job with User-Defined Metadata

See also: Viewing the Overlay Metadata Content.

Applying Graphic Overlays to a Job with a Job Profile 

Procedure

Step 1 From the main menu, click File > New Job Profile. 

or

To add graphic overlays to an existing Job Profile, click Open Job Profile.

A Preprocessor tab displays. 

Step 2 Click the Video subtab, and check one or both of the Preprocess boxes to the right of Bumper and/or 
Trailer, shown in Figure 5-11. 

Figure 5-11 Preprocessor: Video Subtab: Checking Bumper and Trailer Preprocess Boxes

Step 3 Click the Gfx Overlay subtab, shown in Figure 5-12.
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Figure 5-12 Graphics Overlay Subtab

Step 4 Under Overlay Content, check the Enabled box. 

Step 5 Next to Template File, click Select File to locate an .swf template file. 

Step 6 If the .swf requires it, add an .xml file into the Meta-Data File/URL field. 

Step 7 If needed, check the Enabled box next to Overlay Bumper and Overlay Trailer. 

Step 8 Select .swf files, and metadata files, if needed. 

Step 9 Continue applying settings to the job, and Submit it. See also: Step 5: Submit the Job.

Note The overlay will not be visible in the Preview window but will display in the encoded clip and in the 
preprocessed .avi intermediate file. 

Applying Graphic Overlays to a Job with User-Defined Metadata

Not to be confused with the graphics overlay metadata, user-defined metadata (UDM) lets you send 
information to the preprocessor on a job-by-job basis. There are six predefined UDM items that control 
graphic overlays. These UDM items can override any or all of the overlay parameters set in Applying 
Graphic Overlays to a Job with a Job Profile. 
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Procedure

Step 1 Add a job to the Job Log. See also: Step 5: Submit the Job.

Step 2 In the Job Log window, click Edit > Properties.

or 

Right-click the job, and click Properties. 

The User Defined Metadata options display.

Step 3 Double-click in the Value column to add the file paths of the template and metadata files. 

Note If a template .swf file is specified, overlays are automatically enabled, regardless of whether or 
not you checked the corresponding Enable box on the Gfx Overlay subtab, and the file paths set 
on the Gxf Overlay tab are overridden. 

Step 4 Close the Properties pop-up, and continue setting the job. 

Viewing the Overlay Metadata Content

The metadata descriptions listed in Applying Graphic Overlays to a Job with User-Defined Metadata, 
correspond to database items in the "statisticsType" table of the Cisco MXE 3000 DCS database. 

You can view the user-defined metadata items in the prefilter section of the Job XML here: 

<plan>
   <task>
      <parameters>
         <meta-data>
            <udm-item .... />

Creating a Metadata File
The metadata XML file holds metadata items that are transmitted to the Cisco MXE 3000 Graphics 
Overlay Flash Player at particular times in the preprocessed clip. These metadata items must have names 
that correspond to variables in the .swf template file. Use a text editor program to create the XML file. 
The format of the metadata XML file is defined in Flash Overlay Metadata XML: Overlay Control 
Commands. 

Setting .SWF File Metadata Variables 

This XML is used to communicate metadata and other commands affecting the Flash Overlay. It may be 
sent via a text file, which takes effect when the encoder starts, or via the event port, where changes can 
be made in real time during the encoding. 

A typical packet of Flash Overlay XML is a sequence of events, each surrounded by an <event> tag. 

<eventList>
    <event>
        <time>26.5</time>
        <data>      
            <var>
                <name>reporter</name>   
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                <value>John Smith</value>
            </var>
            <var>
                <name>town</name>   
                <value>Boston</value>
            </var> 
        </data>
    </event>
</eventList>

Table 5-13 describes the tags.

Note The metadata in each <event> is transmitted to the Flash Player at the event time. The events need not 
be listed in temporal order. The Flash Player may not respond instantly to metadata changes.

Flash Overlay Metadata XML: Overlay Control Commands

Several commands can be embedded in the metadata XML file to control the appearance of the overlay, 
and can introduce certain types of animation. These commands are not metadata in the same sense as the 
<name><value> pairs. They are provided as a more convenient alternative to re-authoring the template 
file. 

The commands control when the overlay appears and disappears. You may also create fades, wipes, and 
slides. 

Using Animation Controls
Graphic overlays (in addition to their related ActionScript) are usually created with an Adobe program 
such as Flash After Effects or any program that creates an .swf file. In addition, several graphic templates 
come preloaded on the Cisco MXE 3000.

Table 5-13 Tags and Descriptions

Tag Description

<eventList> This tag encloses all the XML for the Flash Overlay metadata.

<event> This tag encloses metadata to be used at a particular time. Multiple <event> children are 
allowed for <eventList> 

<time> This tag encloses the time (floating point, seconds since the start of the clip) for the 
metadata.

<data> This tag encloses the metadata to be sent to the Flash player at the specified time <var>. 
This tag encloses a .swf variable name and value. Multiple <var> children are allowed 
for <event>. 

<var> This tag encloses a .swf variable name and value.   Multiple <var> children are allowed 
for <event>.

<name> This tag encloses the name of a variable in the Flash .swf file. 

<value> This tag encloses a value for the variable in the Flash .swf file. 
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The Cisco MXE 3000 offers animation controls that allow certain changes to the appearance of the 
overlay, via metadata XML tags, and without the need to produce another .swf file. Examples of what 
animation controls allow you to do:

• Easily create fade-in and fade-out or wipes (slides). 

• Use a single .swf file for different media clips, changing only the timing of the overlay appearance. 

• Use a .swf file to create a semi-transparent "bug" logo that appears periodically over the video. 

To create graphic overlays, complete the following procedure.

Procedure

Step 1 To create and adjust graphic overlays, create the .swf file. 

Step 2 Write the ActionScript. 

Step 3 Use a text editor to write the XML file. See also: Graphic Overlay XML Reference.

Graphic Overlay XML Reference

This section includes the following topics:

• Basic Structure of the XML File, page 5-33

• Structure of an Event, page 5-34

• Times and Timecodes, page 5-34

• Event Time and Duration, page 5-34

• The Live Event, page 5-35t

• Opacity, page 5-35

• Transition Control, page 5-36

• Automatic Repetitions, page 5-37

• Flash Movie Control, page 5-38

• Overlay Positioning, page 5-38

• Examples, page 5-39

Basic Structure of the XML File

Animation controls go in the Flash Overlay Metadata XML file, which looks like this:

<eventList>
<event> . . . </event>
<event> . . . </event>
. . .
</eventList>

See also: Flash Overlay Metadata XML: Overlay Control Commands.

• The <event> tags may contain metadata items, timing information, and animation controls. Events 
start at particular times during the video. An event may specify an action that takes place over an 
extended period of time, not just at one instant.

• Event tags may not be nested inside other event tags.
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• The file is read and parsed whenever the file is modified or saved. The overlay algorithm reads and 
acts on all of the events that preceded the current time. A simple example is using one event to define 
the timing of the appearance of an overlay, while another event specifies a metadata value.

• While you can use multiple events, they should not overlap temporally if there is a conflict of 
functionality. If such events overlap, the result is undefined and may not give the desired effect.

Structure of an Event

An event tag may contain commands to control:

• Metadata definitions: See Flash Overlay Metadata XML: Overlay Control Commands.

Metadata definitions may be mixed into any event. These are applied at the beginning of the event 
and "stick", that is, the metadata values are permanent until changed.

• Animation controls: any of the tags below

These control how and when the overlay appears and disappears, how the Flash movie plays, and how it 
is positioned on the video.

Every event is required to have a <time>, <starttime>, or <stoptime> tag.

Times and Timecodes

All tags that refer to time may have values given either in seconds (floating point) or as timecodes. 
Timecodes simply measure a length of time in HH:MM:SS:ff format instead of seconds; they do not 
reference any timecode embedded in the media. For example, the <duration> tag may hold a timecode 
that simply specifies the length of time in HH:MM:SS:ff format. The semicolon notation HH;MM;SS;ff 
may also be used with the standard meaning (two frames dropped every minute except for every 10th 
minute). Timecode values should only be used with PAL or NTSC output rates.

For example, <starttime>21.333</starttime> is equivalent to <starttime>00:00:21:10</starttime> (with 
an NTSC output rate).

The following tags will accept either timecodes or seconds (* means wildcard):

<time>,<starttime>,<stoptime>,<duration>,<fade>,<wipe->,<slide->,<repeat-period>,<repeat-duratio
n>,<repeat-stoptime>

Event Time and Duration

Table 5-14 describes and provides examples for the tags.

Table 5-14 Event Time and Duration Tags and Descriptions

Tags and Examples Description

<starttime> 20.0< /starttime>

or <time>

The start time of the event, in seconds, measured from the 
beginning of the clip. The example shows a start time of 
20.0 seconds. <time> may be used as shorthand for 
<starttime>.
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The Live Event

<live/>

• This special tag indicates that the commands enclosed in this event tag are executed immediately. 
Metadata definitions will be immediately sent to the Flash player renderer for immediate inclusion 
in the overlay. The <live/> tag takes precedence over any <starttime> or <time> tag in the same 
event. When the metadata file is saved, the Cisco MXE 3000 will detect this and read the 
<eventList>. The <live> event will be assigned a start time equal to the current time. 

• The XML file with a <live/> tag should have only one event. If there are multiple live events, only 
the last one in the file will be used. 

• The <live/> event is reinitialized every time the metadata file is written or saved, so if the metadata 
file is written while the live event is active, that event may be restarted. 

• You can use the <duration> tag or <stoptime> tag to define the duration of the live event. 

• You can use transitions, <on-transition> or <off-transition>, to make the overlay appear or 
disappear. Note that in the live case, all transitions are of the <lag/> variety; the <lead/> and 
<center/> tags have no effect. 

Opacity

<opacity-percent> 50 </opacity-percent>

• This tag defines the maximum opacity for an event. 100 means total opacity, which is the default. 
You can set this number lower, for example to 50%, to get a semi-transparent overlay for the duration 
of the event. A partial opacity multiplies any partial opacity due to fade-in or fade-out. 

<duration> 30 </duration> The duration of the event in seconds. By default, the 
duration is infinite. The example shows a duration of 30 
seconds. By default, overlays are removed at the end of the 
duration, although the details are controlled by the 
<off-transition> tag.

<stoptime> 50.0 </stoptime> May be used instead of <duration>. The duration is the 
difference between <stoptime> and <starttime>. If the 
<duration> tag also appears, the shortest time will be used.

Table 5-14 Event Time and Duration Tags and Descriptions (continued)
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Transition Control

Table 5-15 describes and provides examples for the tags.

Note Combinations: It is legal to combine a fade with a wipe or a slide transition, as long as the transition 
times match. If they do not, the fade time is discarded and the wipe or slide time is used for the fading 
as well. 

Table 5-15 Transition Control Tags and Descriptions

Tags and Examples Descriptions

<on-transition> and <off-transition> These are tags that enclose details of how the transitions 
happen. By default, the overlay is applied at the start time 
(this is the on-transition) and removed at the end of the event 
duration (off-transition). However, these tags can alter this 
behavior by introducing fades and wipes. 

<fade> 1.2 </fade> This child tag specifies a fade time in seconds, either fade-in 
or fade-out, depending on whether the parent is an 
on-transition or an off-transition. The example shows a fade 
lasting 1.2 seconds 

<wipe-right> 1.5 </wipe-right> This child tag specifies a wipe time in seconds. The wipe 
travels from left to right. The example shows a wipe lasting 
1.5 seconds. 

<wipe-left> 2 </wipe-left> This child tag specifies a wipe time in seconds. The wipe 
travels from right to left. The example shows a wipe lasting 
2.0 seconds. 

<wipe-up> 2 </wipe-up> This child tag specifies a wipe time in seconds. The wipe 
travels from bottom to top. The example shows a wipe lasting 
2.0 seconds.

<wipe-down> 2 </wipe-down> This child tag specifies a wipe time in seconds. The wipe 
travels from top to bottom. The example shows a wipe lasting 
2.0 seconds. 

<slide-right> 1.5 </slide-right> This child tag specifies a slide time in seconds. The slide 
travels right from the left. The example shows a slide lasting 
1.5 seconds. 

<slide-left> 2 </slide-left> This child tag specifies a slide time in seconds. The slide 
travels left from the right. The example shows a slide lasting 
2.0 seconds. 

<slide-up> 2 </slide-up> This child tag specifies a slide time in seconds. The slide 
travels up from the bottom. The example shows a slide lasting 
2.0 seconds. 

<slide-down> 2 </slide-down> This child tag specifies a slide time in seconds. The slide 
travels down from the top. The example shows a slide lasting 
2.0 seconds. 

<lag/> This child tag specifies that the transitions will lag the event 
time, that is, the transition begins at the event time. This is the 
default behavior, unless the <lead> or <center> tags appear. 
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Automatic Repetitions

Table 5-16 describes and provides examples for the tags.

<lead/> This child tag specifies that the transitions will lead the event 
time, that is, the transition will start early and will complete 
at the event time.

<center/> This child tag specifies that the transitions will be centered 
around the event time, that is, it will start before the event 
time and finish after the event time. 

<nonlinear> 2.0 </nonlinear> This changes the animation of a transition, making it go faster 
at one end and slower at the other. It affects fades, wipes, and 
slides. A value of 1 corresponds to the linear transitions that 
are used by default. Higher values slow the animation close 
to the time when the overlay is fully on, and accelerates the 
animation close to the time when the overlay is fully off. 
Recommended values are 2.0 to 3.0. Slides, in particular, 
benefit greatly with nonlinear motion. 

Table 5-15 Transition Control Tags and Descriptions (continued)

Table 5-16 Automatic Repetition Tags and Descriptions

Tags and Examples Descriptions

<repeat-period> 60.0 </repeat-period> This specifies that the event will automatically repeat 
after a delay time given in seconds. The example 
shows a repeat time of 60 seconds, that is, every 60 
seconds after the first occurrence of the event, it will 
be repeated. Repeating goes on forever, unless 
constrained with one of the tags below. 

<repeat-count> 5 </repeat-count> This specifies the number of times the event will 
occur. It is infinite by default. A value of 1 means the 
event happens one time (as if there were no 
<repeat-period> tag). A value of 0 turns off the event. 
The example shows that the event will occur a total of 
5 times. 

<repeat-duration> 250 </repeat-duration> This specifies that the event will repeat for a certain 
period of time given in seconds. When this time 
expires, the current repetition of the event will 
complete, and no further repetitions will occur. The 
example shows a period of 250.0 seconds. If the 
repeat period was 60 seconds, then this example 
specifies a total of five occurrences of the event. 

<repeat-stoptime> 300 </repeat-stoptime> This specifies that the event will repeat until the video 
time exceeds a value given in seconds. When this time 
is exceeded, the current repetition of the event will 
complete, and no further repetitions will occur. The 
example shows that the repetition in progress at 300.0 
seconds will be the last one. 
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Flash Movie Control

Pausing the Flash player is independent of the overlay process. If the Flash movie is paused, the last 
Flash frame continues to be used for overlay. By synchronizing <pause> and <resume> with overlay 
transitions, it is possible to make the movie resume the playback from the same point where the movie 
stopped when the overlay was removed.

These are 'sticky' states, meaning once an overlay is paused, it will remain paused until there is a resume 
event, regardless of the presence of other events. Events that do only pause or resume may overlap other 
events.

Table 5-17 describes the tags.

Overlay Positioning

Table 5-18 describes the tags.

Table 5-17 Flash Movie Control Tags and Descriptions

Tags Descriptions

<pause/> Stop the Flash player rendering. 

<resume/> Start the Flash player running from the point at which it was paused. 

Table 5-18 Overlay Positioning Tags and Descriptions

Tags Descriptions

<offset-right-pixels>*0</x-offset-right-pixels> Offsets the overlay horizontally by a given number 
of pixels. The default is 0.

<offset-left-pixels>*0</x-offset-left-pixels> Offsets the overlay horizontally by a given number 
of pixels. The default is 0. 

<offset-up-pixels>*10</y-offset-up-pixels> Offsets the overlay vertically by a given number of 
pixels. The default is 0. 

<offset-down-pixels>*10</y-offset-down-pixel
s>

Offsets the overlay vertically by a given number of 
pixels. The default is 0. 

<offset-x-pixels>*0</x-offset-x-pixels> Offsets the overlay vertically by a given number of 
pixels. The default is 0. 

<offset-y-pixels>*0</x-offset-y-pixels> Same as <offset-up-pixels> 

<offset-right-percent>*0</x-offset-right-percen
t>

Offsets the overlay horizontally by a percent of 
image width. The default is 0. 

<offset-left-percent>*0</x-offset-left-percent> Offsets the overlay horizontally by a percent of 
image width. The default is 0. 

<offset-up-percent>*10</y-offset-up-percent> Offsets the overlay vertically by a percent of image 
height. The default is 0. 

<offset-down-percent>*10</y-offset-down-perc
ent>

Offsets the overlay vertically by a percent of image 
height. The default is 0. 

<offset-x-percent>*0</x-offset-x-percent> Same as <offset-right-percent> 

<offset-y-percent>*0</x-offset-y-percent> Same as <offset-up-percent> 
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Examples

This section includes the following examples:

• Basic Overlay Event

• Centering the Transitions

• Spanning Events

• Flash Rendering Delays

• Complex Repeating Event

Basic Overlay Event

This overlay starts at 2 seconds and ends at 2+8=10 seconds, with a 1.5 second fade-in at 2 seconds and 
a 1.5 second fade-out beginning at 10 seconds. The overlay is completely removed at 11.5 seconds.

<event>
<starttime>00:00:02:00</starttime>
<duration>8.0</duration>
<on-transition>
<fade>1.5</fade>
</on-transition>
<off-transition>
<fade>1.5</fade>
</off-transition>
</event>

Centering the Transitions
<event>
<starttime>00:00:02:00</starttime>
<duration>8.0</duration>
<on-transition>
<center/>
<wipe-right>1.5</wipe-right>
</on-transition>
<off-transition>
<center/>
<wipe-left>1.5</wipe-left>
</off-transition>
</event>

Spanning Events

It is possible to use one event to turn on the overlay and use a separate event to turn off the overlay, as 
in this example. In this example the opacity-percent tag is used, and the value 70 must match in both 
events or there will be a discontinuous opacity change at 5.0 seconds.

<event>
<opacity-percent>70</opacity-percent>
<starttime>1.0</starttime>
<on-transition>
<fade>0.5</fade>
</on-transition>
</event>

<event>
<opacity-percent>70</opacity-percent>
<stoptime>5.0</stoptime>
<off-transition>
<fade>0.5</fade>
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</off-transition>
</event>

Flash Rendering Delays

The details of the Flash movie may impact the timing of overlay animation.

Some Flash .swf files do not check the metadata values on every frame, so there may be a significant 
delay between the time a packet of metadata ( <data> ... </data> ) is sent, and the time it appears in the 
overlay. One way to deal with this problem is to set up an event to transmit the metadata before it is 
needed. The example below shows how to send the metadata at time 0 and apply the overlay at time 1, 
ensuring that the Flash movie is updated before it is overlaid.

<event>
<data> <name>scene</name> <value>R</value> </data>
<starttime>0</starttime>
<duration>0</duration>
</event>
<event>
<starttime>1</starttime>
<on-transition/>
</event>

Complex Repeating Event
<event>
<data>
<var> <name>name</name> <value>Transition Test 1</value> </var>
<var> <name>name2</name> <value>Transition Test 2</value> </var>
<var> <name>title</name> <value>Graphic Overlay 1</value> </var>
<var> <name>title2</name> <value>Graphic Overlay 2</value> </var>
</data>
<starttime>0</starttime>
<duration>00:00:02:25</duration>
<repeat-period>00:00:04:10</repeat-period>
<repeat-duration>00:00:20:00</repeat-duration>
<offset-down-percent>8</offset-down-percent>
<offset-right>10.0</offset-right>
<on-transition>
<slide-down>00:00:01:00</slide-down>
<fade>00:00:01:00</fade>
<nonlinear>2.0</nonlinear>
<lag/>
</on-transition>
<off-transition>
<fade>00:00:01:00</fade>
<wipe-left>00:00:01:00</wipe-left>
<lead/>
</off-transition>
</event>
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